
TUTORIAL MANUAL

1 FOUNDATION IN OVERCONSOLIDATED CLAY

In this chapter a first application of PLAXIS 3D is considered, namely the settlement of a
foundation in clay. This is the first step in becoming familiar with the practical use of the
program.

The general procedures for the creation of a geometry, the generation of a finite element
mesh, the execution of a finite element calculation and the evaluation of the output results
are described here in detail. The information provided in this tutorial will be utilised in the
following tutorials. Therefore, it is important to complete this first tutorial before
attempting any further tutorial examples.
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Figure 1.1 Geometry of a square building on a raft foundation

GEOMETRY

This exercise deals with the construction and loading of a foundation of a square building
in a lightly overconsolidated lacustrine clay. Below the clay layer there is a stiff rock layer
that forms a natural boundary for the considered geometry. The rock layer is not included
in the geometry; instead an appropriate boundary condition is applied at the bottom of the
clay layer. The purpose of the exercise is to find the settlement of the foundation.

The building consists of a basement level and 5 floors above the ground level (Figure
1.1). To reduce calculation time, only one-quarter of the building is modelled, using
symmetry boundary conditions along the lines of symmetry. To enable any possible
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mechanism in the clay and to avoid any influence of the outer boundary, the model is
extended in both horizontal directions to a total width of 75 m.

The model is considered in three different cases:

Case A: The building is considered very stiff and rough. The basement is simulated by
means of non-porous linear elastic volume elements.

Case B: The structural forces are modelled as loads on a raft foundation.

Case C: Embedded beams are included in the model to reduce settlements.

1.1 CASE A: RIGID FOUNDATION

In this case, the building is considered to be very stiff. The basement is simulated by
means of non-porous linear elastic volume elements. The total weight of the basement
corresponds to the total permanent and variable load of the building. This approach leads
to a very simple model and is therefore used as a first exercise, but it has some
disadvantages. For example it does not give any information about the structural forces in
the foundation.

Objectives:

• Starting a new project.

• Creation of soil stratigraphy using a single borehole.

• Creation of material data sets.

• Creation of volumes using Create surface and Extrude tools.

• Assigning material.

• Local mesh refinement.

• Generation of mesh.

• Generating initial stresses using the K0 procedure.

• Defining a Plastic calculation.

1.1.1 GEOMETRY INPUT

• Start the PLAXIS 3D program. The Quick select dialog box will appear in which you
can select an existing project or create a new one (Figure 1.2).

• Click Start a new project. The Project properties window appears, consisting of
Project and Model tabsheets.

Project properties

The first step in every analysis is to set the basic parameters of the finite element model.
This is done in the Project properties window. These properties include the description of
the problem, the basic units and the size of the drawing area.
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Figure 1.2 Quick select dialog box

To enter the appropriate properties for the foundation calculation follow these steps:

• In the Project tabsheet, enter "Tutorial 1" as the Title of the project and type
"Settlements of a foundation" in the Comments box (Figure 1.3).

Figure 1.3 Project tabsheet of the Project properties window

• Proceed to the Model tabsheet by clicking either the Next button or the Model tab
(Figure 1.4).

• Keep the default units in the Units box (Length = m; Force = kN; Time = day ).

• The General box indicates a fixed gravity of 1.0 G, in the vertical downward direction
(-z).

• In the γwater box the unit weight of water can be defined. Keep this to the default
value of 10 kN/m3.

• Define the limits for the soil contour as xmin = 0, xmax = 75, ymin = 0 and ymax = 75 in
the Contour group box.

• Click the OK button to confirm the settings.

Hint: In case of a mistake or for any other reason that the project properties need
to be changed, you can access the Project properties window by selecting
the corresponding option in the File menu.
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Figure 1.4 Model tabsheet of the Project properties window

Definition of soil stratigraphy

When you click the OK button the Project properties window will close and the Soil mode
view will be shown. Information on the soil layers is entered in boreholes.

Boreholes are locations in the drawing area at which the information on the position of
soil layers and the water table is given. If multiple boreholes are defined, PLAXIS 3D will
automatically interpolate between the boreholes, and derive the position of the soil layers
from the borehole information.

Hint: PLAXIS 3D can also deal with layers that are discontinuous, i.e. only locally
present in the model area. See Section 4.2.2 of the Reference Manual for
more information.

In the current example, only one soil layer is present, and only a single borehole is
needed to define the soil stratigraphy. In order to define the borehole, follow these steps:

Click the Create borehole button in the side toolbar to start defining the soil
stratigraphy. Click on position (0 0 0) in the geometry. A borehole will be located at
(x , y ) = (0 0). The Modify soil layers window will appear.

• In the Modify soil layers window add a soil layer by clicking on the Add button. Keep
the top boundary of the soil layer at z = 0 and set the bottom boundary to z = −40
m.

• Set the Head value in the borehole column to −2 m (Figure 1.5).

The creation of material data sets and their assignment to soil layers is described in the
following section.

1.1.2 MATERIAL DATA SETS

In order to simulate the behaviour of the soil, a suitable material model and appropriate
material parameters must be assigned to the geometry. In PLAXIS soil properties are
collected in material data sets and the various data sets are stored in a material
database. From the database, a data set can be assigned to one or more clusters. For
structures (like beams, plates, etc.) the system is similar, but different types of structures
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Figure 1.5 Modify soil layers window

have different parameters and therefore different types of data sets.

PLAXIS 3D distinguishes between material data sets for Soils and interfaces, Plates,
Geogrids, Beams, Embedded beams and Anchors.

Open the Material sets window by clicking the Materials button in the Modify soil
layers window.

Hint: In the case that the Modify soil layers window was closed by mistake, it can
be re-opened by double-clicking the borehole in the drawing area or by
selecting the Modify soil layers option from the Soil menu.

• Click the New button in the lower part of the Material sets window. The Soil window
will appear. It contains five tabsheets: General, Parameters, Groundwater,
Interfaces and Initial.

• In the Material set box of the General tabsheet (Figure 1.6), write "Lacustrine Clay"
in the Identification box.

• Select Mohr-Coulomb as the material model from the Material model drop-down
menu and Drained from the Drainage type drop-down menu.

• Enter the unit weights in the General properties box according to the material data
as listed in Table 1.1. Keep the unmentioned Advanced parameters as their default
values.

Hint: To understand why a particular soil model has been chosen, see Appendix B
of the Material Models Manual.
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Figure 1.6 General tabsheet of the Soil and interfaces data set window

Table 1.1 Material properties

Parameter Name Lacustrine clay Building Unit

General

Material model Model Mohr-Coulomb Linear elastic −
Drainage type Type Drained Non-porous −
Unit weight above phreatic level γunsat 17.0 50 kN/m3

Unit weight below phreatic level γsat 18.0 − kN/m3

Parameters

Young's modulus (constant) E ' 1 · 104 3 · 107 kN/m2

Poisson's ratio ν ' 0.3 0.15 −
Cohesion (constant) c'ref 10 − kN/m2

Friction angle ϕ' 30.0 − ◦

Dilatancy angle ψ 0.0 − ◦

Initial

K0 determination − Automatic Automatic −
Lateral earth pressure coefficient K0 0.5000 0.5000 −

• Click the Next button or click the Parameters tab to proceed with the input of model
parameters. The parameters appearing on the Parameters tabsheet depend on the
selected material model (in this case the Mohr-Coulomb model). The Mohr-Coulomb
model involves only five basic parameters (E ', ν ', c',ϕ',ψ'). See the Material Models
Manual for a detailed description of the different soil models and their corresponding
parameters.

• Enter the model parameters E ', ν ', c'ref , ϕ' and ψ of Lacustrine clay according to
Table 1.1 in the corresponding boxes of the Parameters tabsheet (Figure 1.7).

• No consolidation will be considered in this exercise. As a result, the permeability of
the soil will not influence the results and the Groundwater window can be skipped.

• Since the geometry model does not include interfaces, the Interfaces tab can be
skipped.

• Click the Initial tab and check that the K0 determination is set to Automatic. In that
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Figure 1.7 Parameters tabsheet of the Soil and interfaces data set window

case K0 is determined from Jaky's formula: K0 = 1− sinϕ.

• Click the OK button to confirm the input of the current material data set. The created
data set appears in the tree view of the Material sets window.

• Drag the set Lacustrine clay from the Material sets window (select it and hold down
the left mouse button while moving) to the graph of the soil column on the left hand
side of the Modify soil layers window and drop it there (release the left mouse
button).

Hint: Notice that the cursor changes shape to indicate whether or not it is possible
to drop the data set. Correct assignment of the data set to the soil layer is
indicated by a change in the colour of the layer.

The building is modelled by a linear elastic non-porous material. To define this data set,
follow these steps:

• Click the New button in the Material sets window.

• In the Material set box of the General tabsheet, write "Building" in the Identification
box.

• Select Linear elastic as the material model from the Material model drop-down
menu and Non-porous from the Drainage type drop-down menu.

• Enter the unit weight in the General properties box according to the material data set
as listed in Table 1.1. This unit weight corresponds to the total permanent and
variable load of the building.

• Click the Next button or click the Parameters tab to proceed with the input of the
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model parameters. The linear elastic model involves only two basic parameters (E ',
ν ').

• Enter the model parameters of Table 1.1 in the corresponding edit boxes of the
Parameters tabsheet.

• Click the OK button to confirm the input of the current material data set. The created
data set will appear in the tree view of the Material sets window, but it is not directly
used.

• Click the OK button to close the Material sets window.

• Click the OK button to close the Modify soil layers window.

Hint: PLAXIS 3D distinguishes between a project database and a global database
of material sets. Data sets may be exchanged from one project to another
using the global database. The global database can be shown in the Material
sets window by clicking the Show global button. The data sets of all tutorials
in the Tutorial Manual are stored in the global database during the installation
of the program.

1.1.3 DEFINITION OF STRUCTURAL ELEMENTS

The structural elements are created in the Structures mode of the program. Click the
Structures button to proceed with the input of structural elements. To model the building:

Click the Create surface button. Position the cursor at the coordinate (0 0 0). Check
the cursor position displayed in the cursor position indicator. As you click, the first
surface point of the surface is defined.

• Define three other points with coordinates (0 18 0), (18 18 0), (18 0 0) respectively.
Press the right mouse button or Esc to finalize the definition of the surface. Note
that the created surface is still selected and displayed in red.

Click the Extrude object button to create a volume from the surface.

• Change the z value to -2 in the Extrude window (Figure 1.8). Click the Apply button
to close the window.

Figure 1.8 Extrude window
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Click the Select button. Select the created surface using the right mouse button.
Select Delete from the appearing menu. This will delete the surface but the building
volume is retained.

The building volume, as well as the corresponding material data sets have now been
created.

1.1.4 MESH GENERATION

The model is complete. In order to proceed to the Mesh mode click the Mesh tab.
PLAXIS 3D allows for a fully automatic mesh generation procedure, in which the
geometry is divided into volume elements and compatible structure elements, if
applicable. The mesh generation takes full account of the position of the geometry
entities in the geometry model, so that the exact position of layers, loads and structures is
accounted for in the finite element mesh. A local refinement will be considered in the
building volume. To generate the mesh, follow these steps:

Click the Refine mesh button in the side toolbar and click the created building
volume to refine the mesh locally. It will colour green.

Figure 1.9 The indication of the local refinement in the model

Click the Generate mesh button in the side toolbar or select the Generate mesh
option in the Mesh menu. Change the Element distribution to Coarse in the Mesh
options window (Figure 1.10) and click OK to start the mesh generation.

Figure 1.10 Mesh options window
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After the mesh is generated, click the View mesh button. A new window is opened
displaying the generated mesh (Figure 1.11).

Figure 1.11 Generated mesh in the Output window

• Click on the Close tab to close the Output program and go back to the Mesh mode
of the Input program.

Hint: By default, the Element distribution is set to Medium. The Element
distribution setting can be changed in the Mesh options window. In addition,
options are available to refine the mesh globally or locally (Section 7.1 of
Reference Manual).

» The finite element mesh has to be regenerated if the geometry is modified.
» The automatically generated mesh may not be perfectly suitable for the

intended calculation. Therefore it is recommended that the user inspects the
mesh and makes refinements if necessary.

1.1.5 PERFORMING CALCULATIONS

Once the mesh has been generated, the finite element model is complete. Click Staged
construction to proceed with the definition of calculation phases.

Initial conditions

The 'Initial phase' always involves the generation of initial conditions. In general, the initial
conditions comprise the initial geometry configuration and the initial stress state, i.e.
effective stresses, pore pressures and state parameters, if applicable. The initial water
level has been entered already in the Modify soil layers window. This level is taken into
account to calculate the initial effective stress state. It is therefore not needed to enter the
Flow conditions mode.

When a new project has been defined, a first calculation phase named "Initial phase", is
automatically created and selected in the Phases explorer (Figure 1.12). All structural
elements and loads that are present in the geometry are initially automatically switched
off; only the soil volumes are initially active.
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Figure 1.12 Phases explorer

In this tutorial lesson the properties of the Initial phase will be described. This part of the
tutorial gives an overview of the options to be defined even though the default values of
the parameters are used.

The Phases window (Figure 1.13) is displayed by clicking the Edit phase button or
by double clicking on the phase in the Phases explorer.

Figure 1.13 The Phases window for Initial phase

By default the K0 procedure is selected as Calculation type in the General subtree
of the Phases window. This option will be used in this project to generate the initial
stresses.

The Staged construction option is selected as the Loading type. This is the only
option available for the K0 procedure.

The Phreatic option is selected by default as the Pore pressure calculation type.

• The other default options in the Phases window will be used as well in this tutorial.
Click OK to close the Phases window.

• In the Model explorer expand the Model conditions subtree.

• Expand the Water subtree. The water level generated according to the Head value
assigned to boreholes in the Modify soil layers window (BoreholeWaterLevel_1) is
automatically assigned to GlobalWaterLevel.

• Make sure that all the soil volumes in the project are active and the material
assigned to them is Lacustrine clay.
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Hint: The K0 procedure may only be used for horizontally layered geometries with
a horizontal ground surface and, if applicable, a horizontal phreatic level.
See Section 7.3 of the Reference Manual for more information on the K0
procedure.

Construction stage

After the definition of the initial conditions, the construction of the building can be
modelled. This will be done in a separate calculation phase, which needs to be added as
follows:

Click the Add button in the Phases explorer. A new phase, named Phase_1 will be
added in the Phases explorer.

• Double-click Phase_1 to open the Phases window.

• In the ID box of the General subtree, write (optionally) an appropriate name for the
new phase (for example "Building").

• The current phase starts from Initial phase, which contains the initial stress state.
The default options and values assigned are valid for this phase (Figure 1.14).

Figure 1.14 The Phases window for Building phase

• Click OK to close the Phases window.

• Right-click the building volume as created in Section 1.1.3. From the Set material
option in the appearing menu select the Building option. The 'Building' data set has
now been assigned to the building volume.

Hint: Calculation phases may be added, inserted or deleted using the Add, Insert
and Delete buttons in the Phases explorer or in the Phases window.

Execution of calculation

All calculation phases (two phases in this case) are marked for calculation (indicated by a
blue arrow). The execution order is controlled by the Start from phase parameter.
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Click the Calculate button to start the calculation process. Ignore the warning that
no nodes and stress points have been selected for curves. During the execution of a
calculation, a window appears which gives information about the progress of the
actual calculation phase (Figure 1.15).

Figure 1.15 Active task window displaying the calculation progress

The information, which is continuously updated, shows, amongst others, the calculation
progress, the current step number, the global error in the current iteration and the number
of plastic points in the current calculation step. It will take a few seconds to perform the
calculation. When a calculation ends, the window is closed and focus is returned to the
main window.

The phase list in the Phases explorer is updated. A successfully calculated phase is
indicated by a check mark inside a green circle.

Save the project before viewing results.

Viewing calculation results

Once the calculation has been completed, the results can be displayed in the Output
program. In the Output program, the displacement and stresses in the full
three-dimensional model as well as in cross sections or structural elements can be
viewed. The computational results are also available in tabular form. To view the current
results, follow these steps:

• Select the last calculation phase (Building) in the Phases explorer tree.

Click the View calculation results button in the side toolbar to open the Output
program. The Output program will, by default, show the three-dimensional deformed
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mesh at the end of the selected calculation phase. The deformations are scaled to
ensure that they are clearly visible.

• Select Total Displacements→ |u| from the Deformations menu. The plot shows
colour shadings of the total displacements (Figure 1.16).

• A legend is presented with the displacement values at the colour boundaries. When
the legend is not present, select the Legend option from the View menu to display it.

In the Output window click the Iso surfaces button to display the areas having the
same displacement.

Figure 1.16 Shadings of Total displacements at the end of the last phase

Hint: In addition to the Total displacements, the Deformations menu allows for the
presentation of Incremental displacements and Phase displacements.

» The incremental displacements are the displacements that occurred in one
calculation step (in this case the final step). Incremental displacements may
be helpful in visualising failure mechanisms.

» Phase displacements are the displacements that occurred in one calculation
phase (in this case the last phase). Phase displacements can be used to
inspect the impact of a single construction phase, without the need to reset
displacements to zero before starting the phase.

1.2 CASE B: RAFT FOUNDATION

In this case, the model is modified so that the basement consists of structural elements.
This allows for the calculation of structural forces in the foundation. The raft foundation
consists of a 50 cm thick concrete floor stiffened by concrete beams. The walls of the
basement consist of 30 cm thick concrete. The loads of the upper floors are transferred
to the floor slab by a column and by the basement walls. The column bears a load of
11650 kN and the walls carry a line load of 385 kN/m, as sketched in Figure 1.17.
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12.0 m12.0 m

6.0 m6.0 m

385 kN/m385 kN/m

11650 kN

5.3 kN/m2

Figure 1.17 Geometry of the basement

In addition, the floor slab is loaded by a distributed load of 5.3 kN/m2. The properties of
the clay layer will be modified such that stiffness of the clay will increase with depth.

Objectives:

• Saving project under a different name.

• Modifying existing data sets.

• Defining a soil stiffness that increases with depth.

• Modelling of plates and defining material data set for plates.

• Modelling of beams and defining material data set for beams.

• Assigning point loads.

• Assigning line loads.

• Assigning distributed loads to surfaces.

• Deleting phases.

• Activation and deactivation of soil volumes.

• Activation and deactivation of structural elements.

• Activation of loads.

• Zooming in Output.

• Drawing cross sections in Output.

• Viewing structural output.

Geometry input

The geometry used in this exercise is the same as the previous one, except that
additional elements are used to model the foundation. It is not necessary to create a new
model; you can start from the previous model, store it under a different name and modify
it. To perform this, follow these steps:

Start the PLAXIS 3D program. The Quick select dialog box will appear in which the
project of case A should be selected.

• Select the Save project as option in the File menu to save the project under a
different name (e.g. "Tutorial 1b").
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The material set for the clay layer has already been defined. To modify this material set to
take into account the stiffness of the soil increasing with depth, follow these steps:

Open the Material sets window by clicking the Show materials button.

• Make sure that the option Soil and interfaces is selected as Set type.

• Select the Lacustrine clay material set and click the Edit button.

• In the Parameters tabsheet, change the stiffness of the soil E ' to 5000 kN/m2.

• Enter a value of 500 in the E 'inc box in the Advanced parameters. Keep the default
value of 0.0 m for zref . Now the stiffness of the soil is defined as 5000 kN/m2 at
z = 0.0 m and increases with 500 kN/m2 per meter depth.

• Click OK to close the Soil window.

• Click OK to close the Material sets window.

Definition of structural elements

Proceed to the Structures mode to define the structural elements that compose the
basement.

Click the Selection button.

• Right-click the volume representing the building. Select the Decompose into
surfaces option from the appearing menu.

• Delete the top surface by selecting it and pressing the Delete key.

Select the volume representing the building. Click the visualisation toggle in the
Selection explorer to hide the volume.

• Right-click the bottom surface of the building. Select the Create plate option from
the appearing menu.

• Assign plates to the two vertical basement surfaces that are inside the model.
Delete the remaining two vertical surfaces at the model boundaries.

Hint: Multiple entities can be selected by holding the Ctrl button pressed while
clicking on the entities.

» A feature can be assigned to multiple similar objects the same way as to a
single selection.

Open the material data base and set the Set type to Plates.

• Create data sets for the basement floor and for the basement walls according to
Table 1.2.

• Drag and drop the data sets to the basement floor and the basement walls
accordingly. It may be needed to move the Material sets window by clicking at its
header and dragging it.

• Click the OK button to close the Material sets window.

• Right-click the bottom of the surface of the building volume and select the Create
surface load option from the appearing menu. The actual value of the load can be
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Figure 1.18 Location of plates in the project

Table 1.2 Material properties of the basement floor and basement walls

Parameter Name Basement floor Basement wall Unit

Type of behaviour Type Elastic, isotropic Elastic, isotropic −
Thickness d 0.5 0.3 m
Weight γ 15 15.5 kN/m3

Young's modulus E1 3 · 107 3 · 107 kN/m2

Poisson's ratio ν12 0.15 0.15 −

Hint: When specifying a unit weight, please consider the fact that the element itself
does not occupy any volume and overlaps with the soil elements. Hence, it
might be considered to subtract the unit soil weight from the real unit weight
of the plate, beam or embedded beam material in order to compensate for
the overlap. For partially overlapping plates, beams or embedded beams the
reduction of the unit weight should be proportional.

assigned in the Structures mode as well as when the calculation phases will be
defined (Phase definition mode). In this example, the value will be assigned in the
Phase definition modes.

Click the Create line button in the side toolbar.

Select the Create line load option from the additional tools displayed.

• Click the command input area, type "0 18 0 18 18 0 18 0 0 " and press Enter. Line
loads will now be defined on the basement walls. The defined values are the
coordinates of the three points of the lines. Click the right mouse button to stop
drawing line loads.

Click the Create line button in the side toolbar.

Select the Create beam option from the additional tools displayed.
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• Click on (6 6 0) to create the first point of a vertical beam. Keep the Shift key
pressed and move the mouse cursor to (6 6 -2). Note that while the Shift key is
pressed the cursor will move only vertically. As it can be seen in the cursor position
indicator, the z coordinate changes, while x and y coordinates will remain the same.
Click on (6 6 -2) to define the second point of the beam. To stop drawing click the
right mouse button.

• Create horizontal beams from (0 6 -2) to (18 6 -2) and from (6 0 -2) to (6 18 -2).

Hint: By default, the cursor is located at z=0. To move in the vertical direction,
keep the Shift key pressed while moving the mouse.

Open the material data base and set the Set type to Beams.

• Create data sets for the horizontal and for the vertical beams according to Table 1.3.
Assign the data set to the corresponding beam elements by drag and drop.

Table 1.3 Material properties of the basement column and basement beams

Parameter Name Basement column Basement beam Unit

Material type Type Elastic Elastic −
Young's modulus E 3 · 107 3 · 107 kN/m2

Volumetric weight γ 24.0 6.0 kN/m3

Cross section area A 0.49 0.7 m2

Moment of Inertia I2 0.020 0.029 m4

I3 0.020 0.058 m4

Click the Create load button in the side toolbar.

Select the Create point load option from the additional tools displayed. Click at (6 6
0) to add a point load at the top of the vertical beam.

Proceed to the Mesh tabsheet to generate the mesh.

Mesh generation

Click the Generate mesh. Keep the Element distribution as Coarse.

Inspect the generated mesh.

• Click on the Close tab to close the Output program and go back to the Mesh mode
of the Input program.

As the geometry has changed, all calculation phases have to be redefined.

1.2.1 PERFORMING CALCULATIONS

Proceed to the Staged construction mode.

Initial conditions

As in the previous example, the K0 procedure will be used to generate the initial
conditions.

• All the structural elements should be inactive in the Initial Phase.
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• No excavation is performed in the initial phase. So, the basement volume should be
active and the material assigned to it should be Lacustrine clay.

Construction stages

Instead of constructing the building in one calculation stage, separate calculation phases
will be used. In Phase 1, the construction of the walls and the excavation is modelled. In
Phase 2, the construction of the floor and beams is modelled. The activation of the loads
is modelled in the last phase (Phase 3).

The calculation type for the phases representing the construction stages is set by
default to Plastic.

• In the Phases window rename Phase_1 to "Excavation".

• In the Staged construction mode deactivate the soil volume located over the
foundation by selecting it and by clicking on the checkbox in front of it in the
Selection explorer.

• In the Model explorer click the checkbox in front of the plates corresponding to the
basement walls to activate them.

In the Phases explorer click the Add phase button. A new phase (Phase_2) is
added. Double-click Phase_2. The Phases window pops up.

• Rename the phase by defining its ID as "Construction". Keep the default settings of
the phase and close the Phases window.

• In the Model explorer click the checkbox in front of the plate corresponding to the
basement floor to activate it.

• In the Model explorer click the checkbox in front of the beams to activate all the
beams in the project.

Add a new phase following the Construction phase. Rename it to "Loading".

• In the Model explorer click the checkbox in front of the Surface loads to activate the
surface load on the basement floor. Set the value of the z-component of the load to
-5.3. This indicates a load of 5.3 kN/m2, acting in the negative z-direction.

• In the Model explorer, click the checkbox in front of Line loads to activate the line
loads on the basement walls. Set the value of the z-component of each load to
-385. This indicates a load of 385 kN/m, acting in the negative z-direction.

• In the Model explorer click the checkbox in front of Point loads to activate the point
load on the basement column. Set the value of the z-component of the load to
-11650. This indicates a load of 11650 kN, acting in the negative z-direction.

Click the Preview phase button to check the settings for each phase.

As the calculation phases are completely defined, calculate the project. Ignore the
warning that no nodes and stress points have been selected for curves.

Save the project after the calculation.

Viewing calculation results

• Select Construction phase in the Phases explorer.
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Click the View calculation results button to open the Output program. The deformed
mesh at the end of this phase is shown.

• Select the last phase in the Displayed step drop-down menu to switch to the results
at the end of the last phase.

In order to evaluate stresses and deformations inside the geometry, select the
Vertical cross section tool. A top view of the geometry is presented and the Cross
section points window appears. As the largest displacements appear under the
column, a cross section here is most interesting.

• Enter (0.0 6.0) and (75.0 6.0) as the coordinates of the first point (A) and the second
point (A') respectively in the Cross section points window.

• Click OK. A vertical cross section is presented. The cross section can be rotated in
the same way as a regular 3D view of the geometry.

• Select Total displacements→ uz from the Deformations menu (Figure 1.19). The
maximum and minimum values of the vertical displacements are shown in the
caption. If the title is not visible, select this option from the View menu.

Figure 1.19 Cross section showing the total vertical displacement

• Press CTRL+ and CTRL− to move the cross section.

• Return to the three-dimensional view of the geometry by selecting this window from
the list in the Window menu.

• Double-click the floor. A separate window will appear showing the displacements of
the floor. To look at the bending moments in the floor, select M11 from the Forces
menu.

Click the Shadings button. The plot in Figure 1.20 will be displayed.

To view the bending moments in tabulated form, click the Table option in the Tools
menu. A new window is opened in which a table is presented, showing the values of
bending moments in each node of the floor.
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Figure 1.20 Bending moments in the basement floor

1.3 CASE C: PILE-RAFT FOUNDATION

As the displacements of the raft foundation are rather high, embedded beams will be
used to decrease these displacements. These embedded beams represent bored piles
with a length of 20 m and a diameter of 1.5 m.

Objectives:

• Using embedded beams.

• Defining material data set for embedded beams.

• Creating multiple copies of entities.

Geometry input

The geometry used in this exercise is the same as the previous one, except for the pile
foundation. It is not necessary to create a new model; you can start from the previous
model, store it under a different name and modify it. To perform this, follow these steps:

Start the PLAXIS 3D program. The Quick select dialog box will appear in which the
project of Case B should be selected.

• Select the Save project as option in the File menu to save the project under a
different name (e.g. "Tutorial 1c").
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Definition of embedded beam

• Proceed to the Structures mode.

Click the Create line button at the side tool bar and select the Create embedded
beam from the additional tools that appear.

• Define a pile from (6 6 -2) to (6 6 -22).

Open the material data base and set the Set type to Embedded beams.

• Create a data set for the embedded beam according to Table 1.4. The value for the
cross section area A and the moments of inertia I2 and I3 are automatically
calculated from the diameter of the massive circular pile. Confirm the input by
clicking OK.

Table 1.4 Material properties of embedded beam

Parameter Name Pile foundation Unit

Young's modulus E 3 · 107 kN/m2

Unit weight γ 6.0 kN/m3

Beam type - Predefined −
Predefined beam type - Massive circular beam −
Diameter Diameter 1.5 m
Axial skin resistance Type Linear −
Maximum traction allowed at the top of the
embedded beam

Tskin,start ,max 200 kN/m

Maximum traction allowed at the bottom of
the embedded beam

Tskin,end ,max 500 kN/m

Base resistance Fmax 1 · 104 kN

• Drag and drop the Embedded beam data to the embedded beam in the drawing
area. The embedded beam will change colour to indicate that the material set has
been assigned successfully.

• Click the OK button to close the Material sets window.

Hint: A material set can also be assigned to an embedded beam by right-clicking it
either in the drawing area or in the Selection explorer and the Model explorer
and selecting the material from the Set material option in the displayed menu.

Click the Select button and select the embedded beam.

Click the Create array button.

• In the Create array window, select the 2D, in xy plane option for shape.

• Keep the number of columns as 2. Set the distance between the columns to x = 12
and y = 0.

• Keep the number of rows as 2. Set the distance between the rows to x = 0 and
y = 12 (Figure 1.21).

• Press OK to create the array. A total of 2x2 = 4 piles will be created.

Mesh generation

As the geometry model is complete now, the mesh can be generated.
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Figure 1.21 Create array window

Create the mesh. Keep the Element distribution as Coarse.

View the mesh.

• Click the eye button in front of the Soil subtree in the Model explorer to hide the soil.
The embedded beams can be seen (Figure 1.22).

• Click on the Close tab to close the Output program and go back to the Mesh mode
of the Input program.

Figure 1.22 Partial geometry of the model in the Output
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Performing calculations

After generation of the mesh, all construction stages must be redefined. Even though in
practice the piles will be constructed in another construction stage than construction of
the walls, for simplicity both actions will be done in the same construction stage in this
tutorial. To redefine all construction stages, follow these steps:

• Switch to the Staged construction mode.

• Check if the K0 procedure is selected as Calculation type for the initial phase. Make
sure that all the structural elements are inactive and all soil volumes are active. The
material assigned to it is Lacustrine clay.

• Select the Excavation phase in the Phases explorer.

• Make sure that the basement soil is excavated and the basement walls are active.

• Activate all the embedded beams.

• In the Phases explorer select the Construction phase. Make sure that all the
structural elements are active.

• In the Phases explorer select the Loading phase. Make sure that all the structural
elements and loads are active.

Calculate the project.

Save the project after the calculation.

• Select the Loading phase and view the calculation results.

• Double-click the basement floor. Select the M11 option from the Forces menu. The
results are shown in Figure 1.23.

• Adjust the legend by changing scaling settings into:

• Scaling: manual

• Minimum value: -450

• Maximum value: 550

• Number of intervals: 18

• Select the view corresponding to the deformed mesh in the Window menu.

Click the Toggle visibility button in the side toolbar.

• To view the embedded beams press Shift and keep it pressed while clicking on the
soil volume in order to hide it.

Click the Select structures button. To view all the embedded beams, press
Ctrl+Shift keys and double click on one of the piles.

• Select the option N in the Forces menu to view the axial loads in the embedded
beams. The plot is shown in Figure 1.24.

PLAXIS 3D 2018 | Tutorial Manual 29



TUTORIAL MANUAL

Figure 1.23 Bending moments in the basement floor

Figure 1.24 Resulting axial forces (N) in the embedded beams
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